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1.) What is Quoridor?
Quoridor is a board game in which players must traverse across a board in order to win.  Each player is also given a number “walls” in order to lengthen his opponent’s path, or use in facilitating his own path.  Players take turns, and Player 1 goes first.  On a player’s turn, he may either move his given token one space horizontally or vertically, or he may place a wall.  The walls cover the groove between two spaces.  More details about game play can be found in the below sections.  

2.) Rules of Quoridor
There are some rules that govern the classic game of Quoridor, as well as some ones specific to the program.  It should be noted that the Quoridor program prevents any errors from being made.
i.) 2 to 4 players.
ii.) Walls may not overlap each other.
iii.) Walls may only be placed within the grooves of the board.

iv.) On any given turn, there must be at least one possible path for each player to reach their goal, no matter how complex.

v.) Only one token can occupy a space on the board.

vi.) A token can “jump” over another token when adjacent to it.  This means that a token can proceed forward two spaces.  The token may advance to any of the three other spaces around the opponent, provided there is not a wall to that side of the opponent.

vii.) A token may not jump over multiple adjacent tokens.  Only advancing as much as two spaces is permitted.

viii.) A token may not advance into any edge zones except for the target goal zone.

ix.) A player wins the game by advancing their token across the board into their goal zone.
3.) Installing Quoridor

To install Quoridor on your computer, insert the CD into your CD drive, and open a browser for the CD folder.  Click on setup file “setup.exe”, and follow the instructions to install the program to any location of your choice.  After installed, just double-click “Quoridor.exe” to start the program.
4.) Setting Up New Games
Once a user launches the game, it will prompt them with an option screen asking if they would like to start a new game, continue a game in progress, or join a game set up by a host computer.  This screen is shown in Figure 4a below.  Users who would like help with the game can click the “How to Play” button at the bottom.  It will open up a help menu.  At the very bottom, the port number the computer will use for network play can be specified.  The default port number is 12575.
To set up a new game, select “New Game,” and the player setup screen comes up (see Figure 4b below).  (NOTE: A Windows security message may pop up.  Click “Unblock” if this happens.)  A user may set up the information for each player position.  Also this is where a user can change the options of the game.  Basic options include:

The board size (default is 10x10 spaces; range is from 6x6 to 12x12 spaces);

The number of walls each player starts with (can be 0 to 144 per player).
For play involving multiple computers, the computer’s IP address and port number can be found at the bottom of the window.
Then the user selects the status of each player.  For up to 4 players, the following choices may be made:  1.) Hotseat Player;  2.) Remote/AI Player.  After these selections are made, then click “Begin Game” to go to the game board.
The board appears with the number of player tokens depending on how many players were selected.  Player 1 appears in the bottom starting zone, Player 2 appears in the top zone, Player 3 is on the right (if applicable), and Player 4 is on the left (if applicable).  
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Figure 4 — Player Selection screen
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   Figure 4a – Start Menu
           Figure 4b – Player Selection screen

4.1) Hotseat (Basic) Games
To start a Hotseat game (a game that involves one computer with all human players), one could just click “Begin Game.”  The default settings are set for a two-human player game (“Blue” vs. “Red”) with 10 walls and a 10x10 board.  To add additional players, click the check boxes next to Player 3 and/or Player 4.  When the box is checked, that player is activated, and their options can be set.  

Any names may be entered in the player name boxes.  If the player type is not set to “Hotseat Player,” click that button located below the player name.  When ready, click “Begin Game” to start with the desired settings.
4.2) Games over Multiple Computers

If one user is playing another using multiple computers, one user will have to be designated as a “Host,” and the other(s) a “Client.”  The host will set up the game for all the players.  The client will type in the networking information to link up with the host.  The client must know the IP Address and port number of the Host computer they are connecting to.  The Host’s IP Address and port number can be found on the bottom of the Host’s player selection screen.  The default port number is 12575.
Instructions for “Host”:  Before starting, the port number specified on the start menu should be unblocked.  A Windows message may come up during the program that will allow the Host to unblock the application.  To start a Network game, select “New Game” from the starting menu.  First, for any player slot, select “Hotseat Player” (see section 3.3) to represent the Host player (There must be at least one hotseat player).  To enter information for a Client player, select “Remote User” under another player slot.  The list box below “Remote User” should include a list of players attempting to connect to the Host machine.  The list should fill in as clients connect to the Host.  Select a client player from the list.  The information for that player slot fills in using the data the client entered for themselves.  The host can not change the name of the client player once selected.  Once all client players have been declared and options have been specified, click “Begin Game” to start the game over the network.
Instructions for “Client”:  To connect with the designated Host, select “Join a Hosted Game” from the starting menu.  A screen asking for the client player’s name comes up.  Clients may only change their name before connecting – the Host is in charge of all other game settings.  Also, the Client must type in the Host’s IP address and port number.  Once entered, click “Connect.”  The information will be sent to the Host, where they will use the submitted player information to set up the game.  A dialog box appears that asks to wait for the Host to finish setup.  At this point, the connection to the Host may be terminated by clicking “Disconnect.”  When setup is complete, the game board will appear and play will begin.
4.3) Games Involving AI Players
To start a game with AI modules created for the program, select “New Game” from the starting menu.  The player setup screen will come up.  First, for any one player slot, select “Hotseat Player” to represent the hotseat player.  To enter information for an AI player, select “Remote/AI Player” under another player slot.  Below “Remote/AI Player” should appear a dropdown list.  To start an AI module, start up the AI executable outside the game.  The AI module should ask for an IP address and port number, enter them. The AI’s name will appear in the drop down list afterwards. Once all AI players have been declared and options have been specified, click “Begin Game” to start the game.
For example, to start a game with a hotseat player and a Quoridor-included AI module, select “Remote/AI Player” for either Player 1 or 2.  Then, pull up the AI folder included in the program files.  Double-click sampleAIx.exe to activate the AI module (where x can be 1, 2, or 3).  Type in the IP address and port number of the host computer into the form that appears on the screen and connect.  Then, in Quoridor, select the sample AI from the player dropdown list and begin the game.
5.) Setting Up Saved Games
5.1) Hotseat (Basic) Games
To resume a Hotseat game previously saved, select “Load Game” from the starting menu.  Locate and select the file containing the desired .qsv file.  Click “Open.” The player setup screen will come up.  Only the player names may be changed at this point.  After clicking “Begin Game” to continue, the board will be displayed with the status of the game before it was suspended.  
5.2) Games over Multiple Computers
To resume a Network game previously saved, first the Host should select “Load Game” from the starting menu.  Then Locate and select the file containing the desired .qsv file.  Click “Open.” The player setup screen will come up.  Then after the Host is on the Player Setup Screen, the client players connect to the Host.  After clicking “Begin Game” to continue, the board will be displayed with the status of the game before it was suspended.  

5.3) Games Involving AI Players
To resume a game with AI’s previously saved, first activate the AI module.  In Quoridor, select “Load Game” from the starting menu.  Locate and select the file containing the desired .qsv file.  Click “Open.”  The player setup screen will come up.  After clicking “Begin Game” to continue, the board will be displayed with the status of the game before it was suspended.  

6.) Playing the Game
6.1) Basics
After setting up the players, the program starts the game and displays the board.  The board starts with the settings specified on the player setup screen.  Player 1 appears in the bottom starting zone, Player 2 appears in the top zone, Player 3 is on the right (if applicable), and Player 4 is on the left (if applicable).  Each player’s name, color, and wall count can be found on their respective starting side of the board.
By default, the game will start with Player 1.  Then the players take turns in their numerical order.  The current player’s turn is indicated by the highlighting of player information and the words “YOUR TURN” on their respective side of the board.
On a player’s turn, they may move their token or place a wall.  After they do this, the next player continues this procedure, and so on.  It should also be noted that in a network game, a player will be terminated and will lose the game if they are disconnected from the network in any way.  A notification will be displayed to all players, and the game will end.  The players will have the chance to save the games and reload them later.
For the first token move, the player may choose any space on their edge of the board to move.  Once on the board, however, they may not move off the board except on the opposite side (goal zone).

A sample game with 4 players, a 10x10 board, 10 walls each, on the first turn is shown below in Figure 6.1.
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Figure 6.1 – 10x10 board with 4 players, each with 10 walls. The Blue player always goes first.  It is the Blue player’s turn, as indicated by the blue highlighting of the Blue player’s information.  

6.2) Moving a Token
A player’s token may be moved either right, left, forward, or backward.  To move the token, simply click any highlighted space (a preview of the token will be displayed).  These are all legal possibilities for token movement.  
6.3) Placing a Wall
A player may place a wall anywhere on the board, covering two grooves.  Legal wall placements will be indicated by black lines on the grooves.  Black lines are displayed by hovering the mouse over the grooves on the board.  Placing the mouse over vertical grooves displays vertical lines.  Placing the mouse over horizontal grooves displays horizontal lines.  It should be noted that the walls are displayed downward or rightward from the position of the cursor on the groove.  For example, if a player wants to place a vertical wall in the bottom left corner, they need to place the cursor on the groove next to the second space up.  When a desired wall appears, click it, and a black wall will be placed in that position.
6.4) Winning the Game
When a player has advanced their token into their target goal zone, that player has won the game (See Figure 6.4 below).  A message will appear saying who won, and there will be three buttons.  “Show Game Log” will bring up the Game Log window (see Section 8.3).  “New Game” will take all players back to the Start Menu.  “Quit Program” will exit the Quoridor program completely.  
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Figure 6.4 – Red won the game by clicking the Red Goal.  A message box appears that helps navigate through the program at this point.
6.5) Stopping a Game in Progress
Any player may either save or quit a game during play.  To quit without saving the progress, select “Quit Game” under the “File” menu.  If others are playing on other computers, a message will be displayed on their computers saying that a player has quit.  If this occurs, the game will cease, and the other players must save and/or quit.
To save the current state of the game, select “Save Game” under the “File” menu.  Then choose a location on the computer to save the .qsv file for the game.  This file can be loaded by continuing the game at a later time (see Section 4).
7.) Creating AI’s for the Game
7.1) Basic AI Creation Tools Needed

To create an AI, the following things are needed:




1.) Visual Studio .NET 2003 or 2005.




2.) The following files (they are located in the AI Header folder):
· AIHeader.vb

· AssemblyInfo.vb

· ClientNetworkObject.vb

· Game.vb

· GameBoard.vb

· NetworkPlayer.vb

· playerInfo.vb

· sample AI 1.vb

· SampleAI1.vb

· SampleAI1.sln
7.2) Creating the AI


Load up the solution SampleAI1.sln in Visual Studio .NET.  After loading the solution, load up the file SampleAI1.vb.  This file is the file that you will edit to create the AI.


The function getMove() is the function that is called during each of the AI Player’s turns.  The function getMove() is expected to return the X value of a move, the Y value of a move, and the type of move.  For example, X = 1, Y = 1, and Type = ‘M’ has the AI send “Move my token to the array position of (1,1).”  The exact contents of the array will be mentioned later.


getMove() in the sampleAI1 already includes code that separates the cases of your first token movement, the movement to win the game, and all other positions.  To edit code for each case, edit the functions that are called within them.


In getMove(), the case of the first move is tested by: 
If (mee.FirstMove) Then 

The case of a winning state is tested by:

If GameBoard.isWinner(x, y, myNum) Then
The code provided already submits the winning move.


All other cases are handled outside the two if’s.


To program the AI, fill in getMove() with the AI code.  Assume it is always your turn (you will not be in getMove() unless it is your turn).  The gameBoard variable contains all the information you need.

7.3) The Game Board

The AI Header, as well as the rest of the Quoridor program uses a 25 by 25 “array” (a string) to represent the board.

Squares on the array that player tokens may exist on are the array positions whose x and y are both odd numbers.  For example, the array position (1,1) is the upper left corner of the board.  A player exists on that location if the square is a ‘1’, ‘2’, ‘3’, or ‘4’

Possible wall placements are all other squares.  A square is blocked off from another square if a wall exists in the square between them.  For example, the squares (1,1) and (1,3) are blocked off by a wall if there is a ‘W’ at square (1,2).

The edges of the board are not in this array.  If a player is on a goal, their token is not on the array.  This is how that player’s location is determined.  All players start off the array board.

7.4) Writing the AI


getMove() is where the AI is written.  It expects the AI code that is written inside to assign a value to RtnX and RtnY, which are the values of the x and y coordinates of the AI.  Use the data structures explained in Section 7.5 to assist with the writing of your AI.


In getMove(), it is always your AI’s turn.  When it is not your AI’s turn, the AI Header handles all functionality with game communication and updating.  The game’s AIHeader “AI” handles this as well as updates the current board state.  Use AIHeader’s initial values to set your own gameBoard and PlayerInfo type instances to assist in writing the AI.

7.5) The AI Data Structures


The AI Header provides three data structures for you.  In the sample AI, the first two lines of code in getMove() already sets these up for your current turn.

7.5.1 AIHeader
This class contains the master information of the status of the game, as well as handles the connection information with the server.  In the header it is initialized as “AI”.  The code inside should not be modified by the AI writer.



The following functionality is available for the AI writer:




( getMyNum()
(  Returns your player number.




( getNumWalls().  Returns the number of walls you have.

getNumWalls(ByVal playerNum As Int32)
(  Returns the number of walls for that player.
( getboardSize()
(  Returns the board size.
( getPlayerLoc(ByVal playNumber As Integer, ByRef x As Integer, ByRef y As Integer)
(  Loads playerNumber’s location into x and y.

( getBoard(ByRef inoutBoard(,) As String, ByRef Playr() As GameBoard.playerLoc)
(  Loads the current board state into inoutBoard(,), as well as playerLoc of all 4 players.  Used to initialize your own gameBoard class.

( getPlayer(ByRef player As PlayerInfo, ByVal num As Int32)
(  Returns the PlayerInfo for the player whose number is num.

7.5.2 PlayerInfo
This class contains all the information for a player.  In the provided sample AI getMove(), it is the type of the instance of mee, which is the playerInfo for the AI.

The following functionality is available for the AI writer:
( GetXandY(ByRef x As Int32, ByRef y As Int32)
(  Returns this player’s location in the string(x,y) using x and y.
( GetSquareXandY(ByRef x As Int32, ByRef y As Int32)
(  Returns what square the player’s token is located on the quoridor board.

( SetPoss(ByVal x As Int32, ByVal y As Int32)

(  This sets where the player’s token is located.

7.5.3 GameBoard
This class is intended for use of the AI to modify for its needs within its algorithms, as this class represents a board state.  It can be initialized to the game’s current board state and can be modified at any time.
The following functionality is available for the AI writer:
( setWall(ByVal x As Int32, ByVal y As Int32, ByVal type As String)
(  This function places a wall whose center is at the string(x,y).  The wall will be placed like a Horizontal wall when type = “H” and vertical when type = “V”.

( goodWall(ByVal x As Int32, ByVal y As Int32, ByVal type As String)
(  This returns if a wall may be placed at string(x,y).  Type is either “H” for horizontal and “V” for vertical wall. Returns true if the placement is valid.

( movePlayer(ByVal x As Int32, ByVal y As Int32, ByVal player As PlayerInfo)
(  This moves the player on PlayerInfo to the position string(x,y) if the move is valid.  Returns false if the move was not legal (if it was not legal, no change will be made)

( goodPlayer(ByVal x As Int32, ByVal y As Int32, ByVal player As PlayerInfo)
(  This returns true if the player in the passed PlayerInfo could move to string(x,y).

( isplayer(ByVal x As Int32, ByVal y As Int32)
(  This returns if anything is on the board at position (x,y).
( isWinner(ByVal x As Int32, ByVal y As Int32, ByVal playerNum As Int32)
(  Returns if the player “playerNum” can make a move that wins from (x,y).

8.) Additional Features
8.1) Wall Count
On the Player Setup screen, at the bottom, the number of walls may be decreased to as low as 0 or increased to as high as 120 by clicking the arrows to the side of the box.  
8.2) Board Size
On the Player Setup screen, at the bottom, the board size can be set from 6x6 to 12x12 by clicking the arrows to the side of the box.  
8.3) Game Logs
Game logs are textual records of the moves played in a game.  In Quoridor, the logs keep track of what player moves a token and places a wall.  We use a notation to keep track of the spaces on the board much like that of Chess.  This coordinate system labels the board by using two axes.  Starting from the bottom-left of the board, and going right, the spaces are labeled with single letters starting from A.  The grooves are not included in the coordinates.  From the bottom-left and going up, the spaces are numbered starting at 1.  So, the space closest to the bottom-left is referred to as (A 1).  The space to the right of that is (B 1), and the space above that is (B 2).
Game logs can be accessed at any time during the game by clicking “Options” and “Show Game Logs.”  The moves up to this point in the game will be displayed.  On this screen, the logs may be saved as a text file at any time.  Just click the “Save Logs” button at the bottom of the Game Logs window.  Then choose a file location for your text file and click “Save.”  The logs can also be displayed after finishing a game.  When the game notifies that a player has won the game, click the “Show Game Log” button.  The log window will come up.
8.4) Help Menu
All of the details mentioned in this document can be found interactively through the Help Menu located in the game.  Just click on “Help” then “Help Topics” to access the Help Menu.
9.) Glossary

AI (Artificial Intelligence) – refers to an algorithm that runs interactively to act as a logical sequence of actions as reflected by the actions of the human brain.

board – the square platform where tokens and walls are placed upon in Quoridor.

client – the designated players/computers that stand by as the host sets up and manages the game.

game – a session of play starting with tokens off the board and ending when any token reaches the other side of the board respective to its starting edge.
game log – a written representation of each move played in the game.
goal – colored zone on the edge of the board opposite from where a player starts.  A player must reach this area to win the game.

groove – the “lines” that dissect the board, forming spaces.

host – the designated player(s)/computer that are responsible for setting up the game for all other players on different computers, referred to as “clients.”

hotseat – gameplay involving only one instance of a Quoridor game with 2 to 4 players.
jump – refers to the moving of a token past another token one unblocked space to any side of the other token.

local player – a player (human or AI) contained on a computer and not over the network.
move – a player moving from one square on the board to another square.
player – any entity interacting with the board game – can be a live person or an AI module.

remote player – a player (human or AI) contained on a computer over the network.
space – an individual square surrounded by grooves on the game board.

token – a game piece representing the player’s current position on the board.

turn – the procedure in which a player can move their token, place a wall, or pass their turn.

wall – a physical blockage which prevents players from moving across the groove where one is placed.  Walls in Quoridor and in our implementation block two adjacent spaces in a line.

wall placement – placing of a wall in a valid location on the board.
10.) Contributions

User Manual Version 1.0:

Todd Astroth – Wrote all sections

User Manual Version 2.0:

Todd Astroth – Added sections about networking
User Manual Version 3.0:

Todd Astroth – Added sections about AI modules

User Manual and Installation Guide Version 4.0:

Todd Astroth – Added list of figures.  Proofread all text and updated screenshots.

Chris Cobb – Edited some parts for content and continuity.  Helped clarify sections dealing with AI functionality.  Wrote Section 7 (Creating AI’s).  Edited Sections 4.3 and 6.1.[image: image1.png]
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